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Welcome to GMT!

Congratulations on acquiring Graphical MIDI Tools 2.0 (GMT). This plug-in com-
bines Sibelius® scripting language Manuscript with a native/desktop application to 
create a piano roll view window of the score.

With GMT you can create more realistic MIDI mockups within Sibelius. Its interface 
will allow you to:

 ◼ Adjust the sound start and duration of notes.

 ◼ Edit note velocities.

 ◼ Draw your own automation curves for any MIDI continuous controller 
(CC) and pitch bend.

 ◼ Insert Phantom (hidden) notes that are performed on playback but do not 
alter the written score.

Behind the scenes:  how it works
GMT uses Sibelius scripting language Manuscript to interact with a desktop appli-

cation: the GMT’s piano roll window.

 By its nature, Manuscript can not communicate directly with an external applica-
tion, but it can read/write text files.

 The Manuscript plugin and GMT’s piano roll use a text file to communicate with 
each other, sending and receiving messages (pretty much like in a chat).
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When the GMT’s piano roll wants to communicate back with Sibelius (to inform an 
edit has been done), it automatically sends a virtual key stroke (the key indicated as 
the plugin’s shortcut key).

GMT simulates a keyboard stroke (the plugin’s shortcut key)  
every time it needs to communicate with Sibelius.

This makes Sibelius trigger the Manuscript plugin, which reads the communication 
file and updates the score.  All this process is done automatically and is transparent 
to the user, so you don’t have to worry about it. 

GMT online resources
We recommend you read this manual to get the most out of GMT. You can also find 

videos,  additional resources, and the latest software updates in our official website.

www.graphicalmiditools.com

If you encounter any issues, please don’t hesitate to contact support at:

support@graphicalmiditools.com

It’s great to have you on board! We hope you enjoy using this plugin as much as we 
enjoyed creating it!  So, without further ado, let’s start graphical MIDI editing.

 Santiago Barx  
Composer and creator

Sibelius GMT
& œ œ œ
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Installation and Activation

Installing GMT involves two basic steps.

 ◼ First, run the installer which is included in the downloadable .dmg (on 
Mac) or .exe (on Windows)

 ◼ Next: assign a keyboard shortcut to the plugin

Step 1: Running the installer
Run the Graphical MIDI Tools 2 installer which comes with the downloaded .dmg 

(on Mac) or .zip (on Windows) file.

 ◼ On Mac: right click on the Graphical MIDI Tools 2.pkg file and click open.

 ◼ On Windows/PC: double click on Graphical MIDI Tools.exe to run the 
installer.

About the “unknown developer” warning: 
GMT is currently an independent project and  is not registered as a developer for Windows / 
Apple systems (which involves maintaining periodical certificate costs for both platforms). If 
the  project grows in the future, we will include this. 
For the moment, to stay safe, please download the installer from the official website  
(www.graphicalmiditools.com) or authorized resellers. 

Complete the package installer (Mac) /setup wizard (PC):

The Graphical MIDI Tools 2 package Installer (Mac)

2 
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b. Once the installer process is completed, open Sibelius. 

 You should see the “Graphical MIDI Tools 2” option added to the “Plug-ins” menu 
(in the “Home” tab).

 

The Graphical MIDI Tools 2 Option in the Plug-ins menu

Step 2: Assign a keyboard shortcut
The next step is to assign a keyboard shortcut to the plugin. In order for GMT to 

work, it must be used through a keyboard shortcut (not from the menus).

To do this:

a. In Sibelius, go to File > Preferences. From the left column select “Keyboard 
Shortcuts”. You should see the following dialog:

 ◼ (1) In “Tab or Category” choose “Plug-ins”.

 ◼ (2) In “Features” search for the option “Graphical MIDI Tools 2”. 

 ◼ (3) Click on  the“Add…” button.
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Notice: If this is the first keyboard shortcut you add, Sibelius will ask you to create a new “short-
cuts set”, since the “Standard” set cannot be overridden. Click “Yes” and indicate a name for the 
shortcut set (for example “My shortcuts”)

 
 
 

b. Choose a shortcut key. 

IMPORTANT:  The shortcut key must be a single key and not a combination. Using modifi-
ers (SHIFT, CONTROL or ALT) is not allowed, because these are reserved for GMT functionality.

In this example, we use the “Tab” key but you can choose the one that works best 
for you.

Using “Tab” as a shortcut key
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First Run and Activation
Once you have assigned a keyboard shortcut, you are ready to run GMT.

GMT works on a bar basis. To start it up, first select one or more measures from a 
staff in the score. 

Press the plugin shortcut key (e.g. “Tab”). Since this is the first run, the activation 
window will appear, requesting your email and License Key (or free trial  key).

Enter both credentials and click  the “Activate” button. An internet connection is 
required to complete the product activation.
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Offline Activation (optional)
Alternatively,  you can use the offline activation option if your computer is not con-

nected to the internet. Click on the “Offline Activation” button.

A key file  (which contains your license information) will be required.

To obtain a key file follow these steps:

1. Using a computer with an internet connection  visit:

www.graphicalmiditools.com/offline

2. Fill in your email and license/trial key.

3. Your machine ID will be requested too. This code is  provided to you in the Offline 
Activation window.

4. Download the file and save it in a portable storage (e.g USB drive) device.

5. Load the file with the “Load Key File” button.
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The Welcome Window and shortcut key setup
On Activation success, the GMT welcome window will appear

Press “Continue”. GMT will ask you which shortcut key you are using for the plugin. 
Make sure you indicate the same shortcut key you created in Sibelius.



12  Graphical MIDI Tools | User’s Manual

Press “Test the key”. A message box should appear indicating that communication 
with Sibelius has been established.

Understanding how GMT works 
 
GMT simulates a key stroke and sends it to Sibelius every time it needs to connect with it (to 
send and receive information). By triggering the “Manuscript plugin” both applications can 
communicate between each other. 

For more information about this, see the section “Behind the scenes: how it works” in the first 
chapter.

Granting permissions in Mac
If you are on MacOS version 10.15 (Catalina) or higher, a System Preferences dialog 

will appear asking you to grant permissions to the application. This is needed by 
GMT for the purpose of sending the virtual key event.

In the system preferences, click on the lock (at the bottom left), then check the 
“Graphical MIDI Tools” item in the list.
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After testing the key,  press “Done” and you are all set. The GMT Piano Roll window 
should appear.

GMT’s piano roll window
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(this page intentionally left blank)
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The Piano Roll Window

Opening the Piano Roll window
GMT works on a bar basis. To launch it, select one or more measures in Sibelius, 

then press the plugin’s shortcut key.

To open GMT select one ore more bars in the score 
 and press the plugin’s shortcut key

The piano roll window will open, showing the region you have selected.

3 
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Getting started with GMT’s interface
These are the main areas of GMT’s interface:

1. Piano roll grid

9. Solo/Mute
buttons

2. Automation tabs
3. Timeline 5. Close button

4. Drag window
bar

6. Zoom wheels

7. Con�guration 
button8. Additional

modules

 ◼ 1. The piano roll grid: Here you will be able to edit the sound start and dura-
tion of notes, or insert phantom (hidden) notes.

 ◼ 2. The automation color tabs: These tabs open the automation lanes for the 
MIDI CC controller set in the configuration dialog

 ◼ 3. The time line: Displays the bar numbers and beat divisions of the region 
in the score. Click on the light blue area to move Sibelius’ playback line 
position.   
In here you will find the play button, which is used to start/stop playback 
in GMT.

 ◼ 4. The drag window bar: Click and hold the mouse (drag) over the mini-
gray upper bar to reposition GMT’s window around the screen.

 ◼ 5. Close button: Closes GMT’s interface. To re-open select again one or 
more measures and press the plugin’s shortcut key.

 ◼ 6. Zoom wheels: Click and drag over them to zoom horizontally or verti-
cally.

 ◼ 7. The Configuration CFG button: Opens the configuration/preferences 
dialog.

 ◼ 8. Additional modules tabs: The Velocity and Phantom Notes  module tabs 
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are situated in the lower part of the window.

 ◼ 9. Solo/Mute buttons: These will solo or mute the staff (similar to what is 
done in Sibelius mixer)

Expanding the selected region
It is possible to expand the selected region of the score once GMT is open (avoiding 

the need to close and re-select). To do this, click on any side of the roll grid.

You will notice that the bar to be added is highlighted in blue, and with an arrow 
pointing to the expand direction.

 

Click on the left or right side of the roll grid to expand the selection.

 As you expand your selection, the window will auto-resize to fit the new contents, 
until the physical limits of the screen are reached.

Moving and resizing the window

To move the window:
To reposition the window on the screen click over the top gray bar and move the 

mouse while holding down the left mouse button (“drag”).
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To resize the window:
You can resize GMT’s window to your needs. Click and drag on any border of the 

window. 

Zooming in and out
In GMT, you can zoom in or out using several methods.

 ◼ 1. Click and drag the mouse over the “zoom wheel” controls.

 ◼ 2. Use the mouse physical scroll wheel to zoom in vertically.

 ◼ 3. Alternatively, you can click on the upper part of the time line (the dark 
one displaying the bar numbers) and drag up or down to zoom horizon-
tally.

Click and drag over the timeline to zoom in / out horizontally

The Playback Line and Play Button
One handy feature of GMT is controlling Sibelius playback line position from the 

timeline.

Click on the blue area to position the timeline wherever you want.



 The Piano Roll Window 19

Click on the time-line’s lower part to position the playback line.

The play button
GMT comes with it’s own play button. It is located in the top of the playback line. 

This button controls Sibelius’ playback, allowing  you to start/stop it.

You can also start/stop playback using the                   bar while GMT window is open.

Use GMT’s play/stop button to control playback.

GMT and playback control 
As playback progresses you will see the green line moving horizontally across the 

piano roll.

Note: This behaviour is possible if using GMT’s play button. If you start playback from Sibelius 
play button, you will listen to the score with all your edits, but the GMT’s playback line will not 
progress.

SPACE
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Editing start and duration of a 
note’s sound

With GMT it is possible to change the sound start and duration of a note in the 
score. These modifications do not affect the written score, but only the playback.

Fine adjusting where a written note sound should start (or its duration) allows you 
to create more realistic/human-like  MIDI mockups. 

You can, for example, produce a slight arpeggio over a written block chord, emulate 
a rubato passage, or tailor performances where strict note values are not desired. 

Modifying the start of a note’s sound
To change the start position of a sound, click and drag over a note in the piano roll.

Click and drag over a note’s to reposition it’s sound

The gray line represents the written note
You will see that a gray line appears striking through the note’s rectangle. This line 

indicates the real position and duration of the written note. 

Notice that the line is shown only when the sound position or duration has been 
modified from the original/written one.

4 
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The gray lines represent the written note position and duration.

Selecting multiple notes: the lasso tool
To edit multiple notes at the same time, click and drag on an empty area of the pi-

ano roll. The lasso tool will be activated, allowing you to select multiple notes. The 
selected notes are highlighted in blue.

Selecting multiple notes with the lasso tool

You can then edit the sound parameters for all the group just as you do with a single 
note.

Resetting the sound: the eraser tool
To reset the sound of a note to its original start position and duration (i.e. the exact 

written one), use the right mouse button. The eraser tool will be activated. Then drag 
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over the notes you want to reset.

Introducing Sidelanes
If you are familiar with piano rolls, you may notice that GMT incorporated a special 

characteristic.

When a note goes off view (because it belongs to a pitch that is outside the vertical 
visible range), it doesn’t disappear completely. Instead, it is shown with a thin col-
ored line at the top or bottom of the roll grid.

We named these borders at the sides of the grid  sidelanes.

Sidelanes inform you of notes that belong to the measure but are out of the visible range.

With sidelanes you can have a bird’s eye view of all the contents within a measure, 
avoiding the need to scroll up or down.

.

Detailed view of the sidelane.
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Editing Note Velocities

With GMT you can edit notes velocities in a graphical way. To open the Velocity 
lane, click on the lower tab button labeled Ve.

The Velocity lane will show up at the bottom of the piano roll.

The Velocity lane. The gray dashed lines mean that no velocity 
has been specified by the user.

 Initially, you will see gray dashed lines below the notes. These indicate that no  ve-
locity has been specified by the user yet, so Sibelius will decide which velocity to ap-
ply (according to the current expression marking and sound library configuration).

Writing your own velocities
To specify your own velocities click and hold the mouse over the velocity lane.

5 
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Writing note velocities.

Notice how GMT paints the louder notes with a dark color, and the softer ones with 
a lighter one.

Erasing velocities
To restore the velocities to their defaults, use the right mouse button. The eraser 

tool will be activated.

As you remove your velocities, you will see  the dashed lines come back again, in-
dicating that no user velocity has been specified for the notes (i.e. let Sibelius decide 
which ones to use).



 The CC Automation Module 25

The CC Automation Module

With GMT it is possible to draw your custom automation curves for any MIDI con-
tinuous controller (CC) or pitch bend. 

Opening the automation lanes
The automation lanes are activated through the color tabs in the upper part of the 

window. 

The upper color tabs are configurable

Each tab corresponds to a specific MIDI controller. These can be set in the configu-
ration dialog (more on this later). By default GMT comes with these factory settings: 

 ◼ MOD: (MIDI CC #1) Modulation wheel 

 ◼ EXP: (CC #11) Expression control

 ◼ VOL: (CC#7) Volume control

 ◼ PAN: (CC#64) Panning

Drawing your custom curves
To draw a curve, press and hold the left mouse button over the automation lane.  

As you move the mouse, the corresponding nodes will be inserted, sculpting the 
automation curve.

A custom automation curve for the expression (#11) controller.

6 
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The nodes are connected through ramps, producing a smooth transition between 
each other. 

Using the SHIFT key to draw jump  nodes and disable the grid
Pressing the SHIFT  key while drawing will insert jump nodes. In contrast to ramp 

nodes, jump nodes change the value of the curve on the spot, without creating a 
smooth transition between the previous one.

The SHIFT key will also disable the 16th note grid on which the ramp nodes are tied. 
This allows you to draw curves using Sibelius’ maximum MIDI resolution.

Pressing the SHIFT key while drawing inserts “jump” nodes, and it also disables the grid, allowing you to draw freely.

About Sibelius and  MIDI Resolution 

Sibelius has a maximum MIDI resolution of 256 ticks per quarter note. 
This means that you can insert events with up to a 1/256 quarter note 
precision. This is more than sufficient for everyday applications. GMT 
works with such resolution when using either jump nodes or ramp nodes. 
With ramp nodes, the transitions between them  are  done with this level 
of detail. 
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Warning! GMT vs. dynamic markings
Sibelius sends MIDI commands to the playback engine whenever it encounters an 

expression/dynamics marking (like p, f , or a hairpin) to simulate a live perfor-
mance. Normally, these correspond to the MIDI CC #11 (expression).

If you write your own custom automation curves for the expression controller over 
a passage that has dynamics markings (p, f, or a hairpin), the playback engine will 
receive two instructions, not knowing which one to follow, with unpredictable re-
sults.

Disabling the dynamics markings playback
To avoid this, you can disable the dynamics markings from being played at all. In 

Sibelius, open the inspector panel: go to the View tab, and select the Inspector op-
tion, or press CTRL  + SHIFT  + i

Sibelius’ Inspector panel at the left of the screen.

Select the markings you want to disable and, within the inspector, uncheck the first 
(or more) box in the Playback section. 
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The advantage of using GMT curves: they linger on
Aside from giving you the flexibility of drawing your custom shapes, GMT automa-

tion curves have a major advantage over expression markings: they are part of the 
score (commands are hidden texts over the staff) and most importantly, they are 
carried over to the MIDI file when using Sibelius export function .

Sibelius expression markings are not stored as MIDI information in the score. They are interpret-
ed in real-time by the playback engine. When exporting to a MIDI file, any expression marking 
information will be lost, but GMT’s curves will be preserved.

Configuring the automation color tabs
The upper color tabs are fully configurable. To do so, open the configuration dialog  

with the CFG button in the lower right part of GMT’s window.

The configuration “CFG” button in the lower right of GMT’s window

The configuration dialog will show up:

GMT’s configuration/preferences dialog
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Up to eight (8) tabs can be enabled at the same time. Each row in the form sets the 
properties for a given tab:

Tab properties inside the configuration dialog

For each tab you can set up:

 ◼ Enable/disable: Use this checkbox to show/hide the tab.

 ◼ MIDI CC controller: Choose which MIDI continuous controller 

 ◼ Color: Pick a color between the nine possibilities 

 ◼ Label: Use a three letter text which will be displayed as label for the tab.

Loading Factory defaults
At any time you can go back to GMT’s factory default settings. Click on the Load 

Defaults button in the lower left  of the configuration dialog.
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The Phantom Notes module

A new feature introduced in GMT 2 is the Phantom or “hidden” notes module. 
Phantom notes are MIDI command based notes, which are performed by the play-
back engine, but do not affect the written score at all.

Filling  performance gaps
With Phantom notes, it is possible to fill in passages where notation may not be 

fully explicit. For example, in a harp glissando, it is customary to write only the first 
notes, and hint the rest with a line.

The playback engine will normally consider only the written notes in the score, 
missing out the interpretation of the glissando line. 

With phantom notes, it is possible to add these notes. The written score (i.e. the 
spacing and layout) will not be affected at all.

To activate the Phantom notes tool, click the phantom (ghost) icon on the lower tab.

The green lower tab activates the Phantom notes tools

Now you can insert phantom notes. Click and drag over the piano roll grid to insert 
notes.

7 
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The phantom tool inserts phantom notes

You can now complete the performance; notice how phantom notes are shown in 
green, and written notes in red.

 

Modifying phantom notes
You can manipulate the length and position of phantom notes just as you do with 

the sound of written notes. It is also possible to edit their velocities (using the veloc-
ity lane).
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Using Phantom notes as key switches
Another use for phantom notes is to trigger key switches. Some libraries reserve 

certain notes to change the sound / articulation of the current patch.

With phantom notes you can hit these notes without affecting the written score at 
all.

In the following example, we use key switches to change the articulation sound of 
the violin. In this case, the patch comes with these key switches (among others):

Note name MIDI number Articulation
C1 #24 Short sforzato

E1 #28 Pizzicato

G1 #31 Staccato

 

We insert the corresponding phantom notes right before the notes whose sound we 
want to change. 

Using phantom notes as key switches

About MIDI octave numbering
Be careful when looking for key switches specifications in your sound library man-

ual. There are two main conventions for numbering the octaves in the MIDI world: 
calling Middle C “C3” or “C4”. 

In both cases middle C is always MIDI note number #60.
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Sibelius calls middle C “C4”. Many sequencers/DAWs utilize the “C3” convention, 
as is in the early days of MIDI. So watch out for the octave numbering system. If your 
library says “D0”(D-zero) for legato, you will probably need to add one octave to 
make it work  in Sibelius/GMT. Write the key switch on “D1” (D-one). 
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Known limitations and tips

Though we are committed to make our best efforts in order to provide you with the 
best user experience, there are some GMT limitations we want you to know, which 
are present in the current version (2.0). 

Here are some tips as well, so you can make the most out of the plugin:

1. Only one score  at a time is allowed
At the moment GMT works only with one score at a time. If you have two scores 

open in Sibelius, the piano roll will not know which one to address, resulting in un-
defined behaviors. 

2. Prefer GMT’s playback button
GMT provides feedback for the playback line position while Sibelius is playing. This 

is technically possible only if playback is started from GMT’s play button. 

If you start playback from Sibelius, you will hear all your GMT edits, but you won’t 
see the GMT’s playback line moving.

3. Editing/Soloing while in playback
While Sibelius is playing, edits  can actually be done in GMT and they will be  stored 

in the score! But changes will not be heard until playback is stopped and restarted. 

Muting and Soloing a staff while in playback behave in the same way. They will not  
take effect until the next play.

4. Changing the score from Sibelius while GMT is open
If you change notes, or delete MIDI commands from within the score (i.e. using 

Sibelius interface) while GMT is open, you will find that those edits are not reflected 
automatically in the piano roll, until you re-open it.

The “live refresh” is a feature we are working on, but in the meantime, we recom-
mend closing GMT’s window while going back to notation editing.

5. Working with large passages
The GMT plugin sends all information in the selected region to the piano roll win-

dow before showing it on screen. This process is generally fast, especially if you are 
working with one or two staves and passages below a hundred (100) measures long. 

As more instruments and measures are added, you will experience a certain delay 
before the piano roll appears. The waiting time will depend on the complexity of the 
score (more notes, more information) and your computer processing power.

8 
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6. Opening many staves at the same time
Although GMT has no technical limit in the amount of staves it can handle at the 

same time, you will find that its interface is designed (and works better) if used only 
with a few of them at a time. A maximum of four or five staves is recommended. 
From there up, it will depend on your screen resolution and your input device skills. 

Remember you can always edit as many staves as you want if you open them in 
groups.
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